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Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using and 
configuring the EVB-LAN9252-ADD-ON. Items discussed in this chapter include:

• Document Layout

• Conventions Used in this Guide

• The Microchip Web Site

• Development Systems Customer Change Notification Service

• Customer Support

• Document Revision History

DOCUMENT LAYOUT

This document describes how to configure the EVB-LAN9252-ADD-ON, such as the 
DIGIO and SPI, as well as various setup options, scanning, and programming. The 
manual layout is as follows:

• Chapter 1. “Overview” – Shows a brief description of the 
EVB-LAN9252-ADD-ON board quick setup.

• Chapter 2. “DIGIO Configuration” – Provides instructions in configuring DIGIO.

• Chapter 3. “SPI Configuration” – Provides instructions in configuring SPI.

• Appendix A. “Setting Up Master in Windows®” – This appendix shows how to 
set up Master in Windows.

• Appendix B. “EEPROM Programming” – This appendix shows how to program 
EEPROM.

• Appendix C. “Scanning EtherCAT Slaves” – This appendix shows how to scan 
EtherCAT Slaves.

• Appendix D. “Programming PIC24 Firmware” – This appendix shows how to 
program PIC24 firmware.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
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• Appendix E. “Generating SSC Files” – This appendix shows how to generate 
SSC files.
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:
• Compilers – The latest information on Microchip C compilers, assemblers, linkers 

and other language tools. These include all MPLAB C compilers; all MPLAB 
assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK 
object linker); and all MPLAB librarians (including MPLIB object librarian).

• Emulators – The latest information on Microchip in-circuit emulators.This 
includes the MPLAB REAL ICE and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit 3 debug 
express.

• MPLAB IDE – The latest information on Microchip MPLAB IDE, the Windows 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are nonproduction development programmers such as PICSTART Plus and 
PIC-kit 2 and 3.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

www.microchip.com
http://www.microchip.com
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Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: 
http://www.microchip.com/support

DOCUMENT REVISION HISTORY

Revision A (October 2015)

• Initial Release of this Document.

http://www.microchip.com/support
http://www.microchip.com/support
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Chapter 1.  Overview

1.1 INTRODUCTION

The scope of this document is to describe the EVB-LAN9252-ADD-ON board quick 
setup which supports a Digital I/O PDI Interface and SPI+GPIO Interface. This board 
is intended to be used together with the Beckhoff EL6800 platform.

1.1.1 Abbreviations

IDE - Integrated Development Environment

ESC - EtherCAT® Slave Controller

EVB - Evaluation Board

HAL - Hardware Abstraction Layer

HBI - Host Bus Interface

SPI - Serial Protocol Interface

SSC - Slave Stack Code
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Chapter 2.  DIGIO Configuration

2.1 BOARD SETUP

The following steps describe how to set up the board:

1. Replace the FB1111-0142 Piggy Back Controller board with 
EVB-LAN9252-ADD-ON. This is located in the top most left hand corner of the 
EL9800 platform.

2. In the EVB-LAN9252-ADD-ON, configure the following:

a) Close (1-2) of J1.

b) Change the switch SW2 to Dig-IO.

3. In the EL9800, configure the following

a) Close (1-2) of J1201.

b) Configure the “PDI Selection” switch to position 6 (PDI 6: 8 IN/24 OUT).

2.2 MASTER CONFIGURATION

The following steps describe how to configure DIGIO:

1. Refer to Appendix A. “Setting Up Master in Windows®” to configure the Twin-
CAT® in Windows®.

2. Download and extract the “LAN9252Add-On-PIC24_SDK_Vx.xx.zip” from Micro-
chip website.

3. In SDK, “\ESI Files” directory contains the ESI files which can be loaded to 
LAN9252 EEPROM using TwinCAT, as seen in Figure 2-1.

FIGURE 2-1: ESI FILES DIRECTORY 

4. Digital IO ESI files

Dig_8IN_8OUT.xml - Configures LAN9252 in DIG-IO with 8 pins as input and 8 
pins as output. 

5. Copy Digital-IO ESI file to the directory path “C:\TwinCAT\Io\EtherCAT” then 
launch TwinCAT system manager.

6. Launch TwinCAT and scan EtherCAT slaves from TwinCAT. Refer to Appendix 
C. “Scanning EtherCAT Slaves” to scan the slaves.

7. Program “9252 8 Ch. Dig. In-/Output 2xMII (No DC)” EEPROM configuration. 
Refer to Appendix B. “EEPROM Programming” for EEPROM programming. If 
the EEPROM is programmed successfully, the device state will enter into ‘OP’ 
mode as displayed in Figure 2-2.

Note: x.xx denotes the version number of the SDK
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FIGURE 2-2: OP MODE 

2.3 DIGIO DEMO

2.3.1 DIGIO Outputs

The following steps describe how to configure DIGIO outputs:

1. Follow the steps as mentioned in the Section 2.1 “Board Setup” to configure 
the master.

2. Click “Output” as highlighted in Figure 2-3 and then write values on the right side 
panel of TwinCAT by clicking “Write” button.

FIGURE 2-3: DIGIO OUTPUT .

The Set Value Dialog displays, as displayed in Figure 2-4.

Note: If it changes to OP mode as highlighted above, then the device is in opera-
tional state. Otherwise there is an issue with the setup.
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FIGURE 2-4: SET VALUE DIALOG 

3. Once the values are written corresponding DIGIO LEDs (PORT B) should 
change to ON/OFF state.

2.3.2 DIGIO Inputs

The following steps describe how to configure DIGIO outputs:

1. Follow the steps as mentioned in the Section 2.1 “Board Setup” to configure 
the master.

2. Click “Input” as highlighted in Figure 2-5 and then read values on the right side 
panel of TwinCAT.

FIGURE 2-5: DIGIO INPUT .

3. Change the state of the switch (PORT A) to ON/OFF then the values will be dis-
played accordingly in TwinCAT as highlighted in Figure 2-5.
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Chapter 3.  SPI Configuration

3.1 BOARD SETUP

The following steps describe how to set up the board:

1. Replace the Beckhoff EtherCAT board with the EVB-LAN9252-ADD-ON board in 
the EL9800 base board.

2. In the EVB-LAN9252-ADD-ON, configure the following:

a) Close (1-2) of J1.

b) Change the switch SW2 to SPI.

3. In the EL9800, configure the following

a) Close (1-2) of J1201.

b) Configure the “PDI Selection” switch to position 7 [PDI 7: PIC (SPI)].

3.2 MASTER CONFIGURATION

The following steps describe how to configure SPI:

1. Refer to Appendix A. “Setting Up Master in Windows®” to configure the Twin-
CAT in Windows.

2. Download and Extract the “LAN9252Add-On-PIC24_SDK_Vx.xx.zip” from the 
Microchip website.

3. In SDK, “\ESI Files” directory contains the ESI files which can be loaded to 
LAN9252 EEPROM using TwinCAT, as seen in Figure 3-1.

FIGURE 3-1: ESI FILES DIRECTORY 

4. Digital IO ESI file:

Dig_8IN_8OUT.xml - Configures LAN9252 in DIG-IO with 8 pins as input and 8 
pins as output. 

5. Copy the Digital-IO ESI file to the directory path “C:\TwinCAT\Io\EtherCAT” then 
launch TwinCAT system manager.

6. Launch TwinCAT and scan EtherCAT slaves from TwinCAT. Refer to Appendix 
C. “Scanning EtherCAT Slaves” for directions on scanning the slaves.

7. Program “9252 8 Ch. Dig. In-/Output 2xMII (No DC)” EEPROM configuration. 
Refer to Appendix B. “EEPROM Programming” for EEPROM programming. If 
the EEPROM is programmed successfully, the device state will enter into ‘OP’ 
mode as displayed in Figure 3-2.

Note: x.xx denotes the version number of the SDK
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FIGURE 3-2: OP MODE 

3.3 DIGIO DEMO

3.3.1 DIGIO Outputs

The following steps describe how to configure DIGIO outputs:

1. Follow the steps as mentioned in the Section 3.1 “Board Setup” to configure 
the master.

2. Click “Output” as highlighted in Figure 3-3 and then write values on the right side 
panel of TwinCAT by clicking “Write” button.

FIGURE 3-3: DIGIO OUTPUT .

The Set Value Dialog displays, as displayed in Figure 3-4.

Note: If it changes to OP mode as highlighted above, then the device is in opera-
tional state. Otherwise there is an issue with the setup.
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FIGURE 3-4: SET VALUE DIALOG 

3. Once the values are written, corresponding DIGIO LEDs (PORT B) should 
change to ON/OFF state.

3.3.2 DIGIO Inputs

The following steps describe how to configure DIGIO outputs:

1. Follow the steps as mentioned in the Section 3.1 “Board Setup” to configure 
the master.

2. Click “Input” as highlighted in Figure 3-5 and then read values on the right side 
panel of TwinCAT.

FIGURE 3-5: DIGIO INPUT .

Change the state of the switch (PORT A) to ON/OFF then the values will be dis-
played accordingly in TwinCAT as highlighted in Figure 3-5.
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Appendix A. Setting Up Master in Windows®

A.1 INTRODUCTION

This appendix shows how to set up Master in Windows®.

Download and install TwinCAT on Windows from http://beckhoff.com.

A.1.1 TwinCAT Ethernet Driver - Installation

To install the TwinCAT Ethernet Driver, do the following:

1. If TwinCAT installed successfully, a TwinCAT icon will display in the bottom-right corner of the desk-
top. After clicking the icon, a pop-up list will display. Select “System Manager,” as displayed in 
Figure A-1.

FIGURE A-1: SYSTEM MANAGER

2. Go to “Options > Show Real Time Ethernet Compatible Devices…” as in Figure A-2.

http://beckhoff.com
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FIGURE A-2: SHOW REAL TIME ETHERNET COMPATIBLE DEVICES

3. Select the Network adapter and install the TwinCAT driver as in Figure A-3.
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FIGURE A-3: ETHERNET ADAPTERS DIALOG

4. Once the TwinCAT driver is installed successfully, the driver becomes compatible with the TwinCAT 
master. Now the network adapter will be moved to “Installed and ready to use devices” as displayed 
in Figure A-4.
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FIGURE A-4: INSTALLED AND READY TO USE DEVICES

5. Go to corresponding network adapter properties and then select TwinCAT drivers as displayed in 
Figure A-5 and Figure A-6.
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FIGURE A-5: NETWORK ADAPTER PROPERTIES MENU
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FIGURE A-6: LOCAL AREA CONNECTION PROPERTIES

Note 1: Only Select TwinCAT drivers.

2: If the TwinCAT cannot find the EtherCAT slaves after following the steps in Appendix 
C. “Scanning EtherCAT Slaves”, restart the computer and attempt for scanning again.
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Appendix B. EEPROM Programming

B.1 INTRODUCTION

This appendix shows how to program EEPROM.

B.1.1 EEPROM Programming

To program EEPROM:

1. After a successful scan, click the “Device 2 (EtherCAT)” drop-down bar on the left panel of the Twin-
CAT tool. Then click the “Online” tab on the right-side panel of the TwinCAT tool. Right-click the 
LAN9252 listing and select “EEPROM Update” from the contextual menu as displayed in Figure B-1.

FIGURE B-1: EEPROM UPDATE

2. Upon selecting “EEPROM Update”, the Write EEPROM window will open. Select the corresponding 
EEPROM configuration then click the “OK” button to initiate EEPROM programming as in Figure B-2.
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FIGURE B-2: WRITE EEPROM DIALOG
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Appendix C. Scanning EtherCAT Slaves

C.1 INTRODUCTION

This appendix shows how to scan EtherCAT Slaves.

C.1.1 Scanning EtherCAT Slaves

To scan EtherCAT Slaves, do the following:

1. Connect IN port of the device to master using RJ45 Ethernet cable, and then power up the board.

2. If any devices are present, delete them accordingly by clicking the device and selecting “Delete 
Device,” as displayed in Figure C-1.

FIGURE C-1: DELETE DEVICE

3. Scan for EtherCAT slave devices by clicking “I/O devices” and selecting “Scan Devices” as displayed 
in Figure C-2.
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FIGURE C-2: SCAN DEVICES MENU

4. Click to OK to continue scanning, as displayed in Figure C-3.

FIGURE C-3: DEVICE DIALOG

If the check box is unchecked as displayed in Figure C-4 then either the device is not functional or the 
driver was not installed properly.
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FIGURE C-4: DEVICE DIALOG, UNCHECKED

5. Click Yes as displayed in Figure C-5 to scan for boxes.

FIGURE C-5: CONFIRMATION DIALOG

The device list displays as displayed in Figure C-6.
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FIGURE C-6: DEVICE LIST



EVB-LAN9252-ADD-ON
BOARD SOFTWARE

QUICK START GUIDE

 2015 Microchip Technology Inc. DS50002422A-page 35

Appendix D. Programming PIC24 Firmware

D.1 INTRODUCTION

This appendix shows how to program PIC24 firmware.

There are two methods, either using the on-board programmer or using the PICkit 3 programmer.

D.1.1 Programming PIC24 Firmware Using On-Board Programmer

If the user does not have the PICkit 3 programmer, follow these steps to use the on-board programmer:

1. Download and install “MPLAB IDE 8.92” and “XC16 Compiler” from the following link: 
http://www.microchip.com/pagehandler/en-us/devtools/dev-tools-parts.html

2. Connect the “EL9800 On-board PIC Programmer” to the host using USB cable. The switch SW600 in 
EL9800 must be turned to “ON” position.

3. Once the programmer is connected, the device will be listed in the device manager as displayed in 
Figure D-1 (Windows 32-bit) and Figure D-2 (Windows 64-bit).

FIGURE D-1: ON-BOARD PROGRAMMER, WINDOWS 32-BIT

FIGURE D-2: ON-BOARD PROGRAMMER, WINDOWS 64-BIT

4. Open the MPLAB Project “..\MPLAB_IDE\PIC24-SPI.mcp” from the delivered SDK as in Figure D-3.

Note: If the device is not listed as displayed above, install the “MPLAB ICD 2 driver” manually from the 
MPLAB IDE install location “C:\Program Files\Microchip\MPLAB IDE\ICD2\Drivers”

Note: If the device is not listed as displayed above, install the “MPLAB ICD 2 driver” manually from the 
MPLAB IDE install location “C:\Program Files\Microchip\MPLAB IDE\ Drivers64”

http://www.microchip.com/pagehandler/en-us/devtools/dev-tools-parts.html
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FIGURE D-3: MPLAB PROJECT

5. Select “Microchip XC16 Toolsuite” from the “Select Language Toolsuite” option and update each path 
of the “Toolsuite contents” as displayed in Figure D-4.

FIGURE D-4: SELECT LANGUAGE TOOLSUITE DIALOG 

6. Select the “Programmer” as “MPLAB ICD 2” as displayed in Figure D-5.

FIGURE D-5: MPLAB ICD 2 MENU OPTION

7. Once the programmer is selected, the message will appear as displayed in Figure D-6.
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FIGURE D-6: MPLAB ICD 2 TAB

8. The steps must be followed to program target device as displayed in Figure D-7.

a) Select the “Release” option.

b) Click the “Build all” icon.

c) Click the “Program target device” icon.

FIGURE D-7: PROGRAM TARGET DEVICE STEPS

9. Once the programming succeeds, change the switch SW600 to position “1” and restart the EL9800 
board.

D.1.2 Programming PIC24 Firmware Using PICkit 3 Programmer

If the user does has the PICkit 3 programmer, follow these steps:

1. Download and Install “MPLAB X IDE” and “XC16 Compiler” from the following link:
http://www.microchip.com/pagehandler/en-us/devtools/dev-tools-parts.html

2. Connect the PICkit 3 programmer to J1005 in the EL9800 using the fly wires as displayed below.

For example, the pin 1 (VPP/MCLR#) of the PICkit 3 has to be connected with the pin 4 (MCLR#) of 
J1005

3. Open the MPLAB X IDE and open the project “PIC24-SPI” from the delivered SDK as in Figure D-8.

Note: If you do not get the message as displayed above, power cycle the EL9800 board and reconnect 
the on-board programmer to the host.

TABLE D-1: FLY WIRES CONFIGURATION

PICkit 3 Pins J1005 Pins

1 (VPP/MCLR#) 4 (MCLR#)

2 (VDD Target) 1 (3.3V)

3 (VSS GND) 5 (GND)

4 (ICSPDAT/PGD) 3 (RC13/PGD2)

5 (ICSPCLK/PGC) 2 (RC14/PGC2)

http://www.microchip.com/pagehandler/en-us/devtools/dev-tools-parts.html
http://www.microchip.com/pagehandler/en-us/devtools/dev-tools-parts.html
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FIGURE D-8: OPEN PROJECT DIALOG

4. Set the project as main project by clicking the “Make and Program main project” icon as displayed in 
Figure D-9.

FIGURE D-9: MAKE AND PROGRAM MAIN PROJECT ICON

5. Once the programming has completed, restart the EL9800 board.



EVB-LAN9252-ADD-ON
BOARD SOFTWARE

QUICK START GUIDE

 2015 Microchip Technology Inc. DS50002422A-page 39

Appendix E. Generating SSC Files

E.1 INTRODUCTION

This appendix shows how to generate SSC files.

E.1.1 Generating SSC Files

To generate SSC files, do the following:

1. Start the SSC Tool from the Windows Start menu as displayed in Figure E-1.

FIGURE E-1: SSC TOOL IN WINDOWS START MENU

2. In the menu bar, click “File” and then “New” to continue as in Figure E-2.

FIGURE E-2: MENU BAR NEW

3. Click “Import” to import the SSC Tool configuration file “Microchip_LAN9252Add-On-EL9800Base-
Board.xml” from the directory “{SDK_INSTALL_PATH}/LAN9252Add-On-PIC24_SDK_V0.1/” as in 
Figure E-3.
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FIGURE E-3: IMPORT DIALOG

4. After selecting the file, click “Open” to import the SSC Tool configuration file as displayed in 
Figure E-4.

FIGURE E-4: IMPORT CONFIGURATION FILES DIALOG

5. Once imported, check the “Custom” drop-down box, select “Microchip-SPI-GPIO | 
EL9800-Base-Board” configuration, and click “OK” as displayed in Figure E-5.
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FIGURE E-5: CUSTOM DROP-DOWN BOX IN IMPORT DIALOG

6. It contains multiple categories where the SSC can be configured. Refer to the “Help” drop-down menu 
in the tool bar for additional configuration information.

7. Click the “Project” drop-down menu in the tool bar and select “Create New Slave Files”. The pop-up 
window as displayed in Figure E-6.

FIGURE E-6: CREATE NEW SLAVE FILES DIALOG

8. Click the “Start” button to create a new project file, Src folder, and esi file (Slave Information file) in the 
desired directory path.

9. A pop-up window will indicate that the files have been successfully created. Click “OK” to continue.

10. Browse to the directory where the new files were created, as displayed in the example in Figure E-7:

Src (Folder): This folder contains the Beckhoff SSC.
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PIC24 EtherCAT Slave (ESP): This is the SSC Tool project file. 

PIC24 EtherCAT Slave (XML): This is the EtherCAT slave information file that must be used as an 
input to the EtherCAT master tool to configure EtherCAT slave controllers.

FIGURE E-7: SOURCE FOLDER

11. Delete “el9800hw.c” and “el9800hw.h” files inside the Src folder.

12. Copy all the files inside the Src folder to the following directory:

“{SDK_INSTALL_PATH}/ LAN9252Add-On-PIC24_SDK_V0.1 /SSC/Common”

Note: “SSC/Common” directory contains “el9800hw.c” and “el9800hw.h” files where HAL layer is mod-
ified according to the LAN9252 specification.
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NOTES:
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